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Electrocardiogram and Heart Sounds
An introduction to the recording and analysis of electrocardiograms, and the sounds of
the heart.

Written by Staff of ADInstruments

Introduction
The beating of the heart is accompanied by both electrical activity and sound. The pattern of electrical
activity produced by each heart beat cycle is called the electrocardiogram or ECG. The aim of this session
is to record and analyze an ECG from a student volunteer, and to examine the relationship between the ECG
and the characteristic sounds of the heart.

Background
The heart is a dual pump that pushes blood around the body and through the lungs. Blood enters the atrial
chambers of the heart at a low pressure and leaves the ventricles at a higher pressure; it is this high
arterial pressure that provides the energy to force blood through the circulatory system. Figure 1 shows the
organization of the human heart and the circulatory system, in schematic form. Blood returning from the
body arrives at the right side of the heart and is pumped through the lungs to pick up oxygen and release
carbon dioxide. This oxygenated blood then arrives at the left side of the heart, from where it is pumped
back to the body.
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Figure 1. A schematic diagram of the human heart and circulatory system.

Cardiac contractions are not dependent upon a nerve supply. A group of weak muscle cells (sinoatrial or
sinuatrial node, SA node) acts as the pacemaker for the heart (Figure 2). These cells rhythmically produce
action potentials that spread through the fibers of the atria. The resulting contraction pushes blood into the
ventricles. The only electrical connection between the atria and the ventricles is via the atrioventricular (AV)
node. The action potential spreads slowly through the AV node (thus giving a time delay for ventricular
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filling) and then rapidly through the AV bundle and Purkinje fibers to excite both ventricles. The large muscle
mass of the ventricles allows powerful contractions.
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Figure 2. Components of the human heart involved in conduction.

Each side of the heart is provided with two valves, to convert rhythmic contractions into a unidirectional
pumping. The valves close automatically whenever there is a pressure difference across the valve that would
cause backflow of blood. Closure gives rise to audible vibrations (heart sounds). Atrioventricular (AV)
valves between the atrium and ventricle on each side of the heart prevent backflow from ventricle to atrium.
Semilunar valves are located between the ventricle and the artery on each side of the heart, and prevent
backflow of blood from artery to ventricle. The cardiac cycle involves a sequential contraction of the atria and
the ventricles. The combined electrical activity of the different myocardial cells produces electrical currents
that spread through the body fluids. These currents are large enough to be detected by recording electrodes
placed on the skin. The regular pattern of peaks produced by each heart beat cycle is called the
electrocardiogram or ECG (Figure 3).
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Figure 3. A typical ECG showing the fundamental parts that make up the signal.

The action potentials recorded from atrial and ventricular fibers are different from those recorded from
nerves and skeletal muscle. The cardiac action potential is composed of three phases: a rapid depolarization,
a plateau depolarization (which is very obvious in ventricular fibers), and a repolarization back to resting
membrane potential.
The components of the ECG can be correlated with the electrical activity of the atrial and ventricular muscle:

• the P-wave is produced by atrial depolarization
• the QRS complex is produced by ventricular depolarization; atrial repolarization also occurs during

this time
• the T-wave is produced by ventricular repolarization.
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The characteristic sound produced by the heart is usually referred to as a ‘lub-dup’ sound. The lower-pitched
‘lub’ sound occurs during the early phase of ventricular contraction and is produced by closing of the
atrioventricular valves (the mitral valve and tricuspid valve), which prevent blood from flowing back into the
atria. When the ventricles relax, the blood pressure drops below that in the artery and the semilunar valves
(aortic and pulmonary) close, producing the higher-pitched ‘dup’ sound.

Required Equipment
The experiment has been designed for and tested on a PowerLab 4/20T system, although it can easily be
adapted for other PowerLab systems.
This general setup is used for all the exercises in this experiment. The PowerLab 4/20T should already be
connected up to your computer and turned on. The equipment required for these exercises is:

A computer system
Chart software version 5.0 or later
PowerLab (with built-in Bio Amp or PowerLab and Bio Amp front-end)
Five-lead Shielded Bio Amp Cable & snap-connect Lead Wires
Three reusable clamp electrodes or disposable adhesive electrodes
Electrode cream (for use with the clamp electrodes)
Alcohol swabs (70% ethanol on cotton wool or paper tissue); optional
Ballpoint pen
Abrasive pads/gel
Push-button switch
Stethoscope

Procedures

Subject preparation
The student volunteering for the experiment should remove any watch, jewelry and so on from his or her
wrists and ankles.

1. Connect the push-button switch to the BNC socket for Input 2 (see Figure 4 for the equipment setup).

2. Plug the Bio Amp cable into the Bio Amp socket.

3. Connect the leads to Earth, CH1 negative and CH1 positive, on the Bio Amp cable.

4. If alcohol swabs are available, firmly swab the skin with them in each area where electrodes will be
placed (Figure 5). Using a pen, mark each area with a small cross. Lightly abrade the skin at these areas
with an abrasive pad/gel. This decreases the electrical resistance of the outer layer of skin and ensures
good electrical contact.

5. If you are using the reusable clamp electrodes, apply a small amount of electrode cream to the
electrodes, attach the electrodes to the subject as described below, and connect the electrodes to the
leads.  If you are using the disposable electrodes (which have electrode gel on them already), just attach
the electrodes to the subject as described below, and connect the electrodes to the leads.

6. Ensure the volunteer is relaxed and sits as still as possible to minimize any signal from movement.
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Figure 4. The equipment setup for this experiment.

Attaching the electrodes
1. Standard connection: attach the positive electrode to the left wrist, the negative to the right wrist,

and the ground to the right leg. If after looking at the signal in the Bio Amplifier dialog box during the
first exercise you find that this does not produce a good signal, you can use the alternative method
shown (Figure 5.).

2. Alternative connection: attach the positive electrode to the left upper arm, the negative to the right
upper arm and the ground to either wrist. NOTE: Do not place the electrodes over the major
muscles of the upper arm because muscle activity interferes with the signal recorded from
the heart.  Attach the electrodes on the outer side of the arm, midway between the elbow and the
shoulder.
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Figure 5. Connecting the electrodes to the volunteer: two alternative methods.
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Starting the software
To set up recording for this experiment, you load a settings file from the Experiments Gallery. If your tutor
has made other arrangements, for instance, the Experiments Gallery does not contain the required settings
file, or you have to set up the file manually, then follow their instructions. Otherwise continue.

1. Locate Chart on your computer and start the software in the usual way. If the Experiments Gallery dialog
box does not appear in front of the Chart window, choose the Experiments Gallery… command from the
File menu.

2. In the Experiments Gallery dialog box, select this experiment (Electrocardiogram & Heart Sounds) in the
left-hand list. Select the “ECG Settings” file in the right-hand list, then click the Open button to apply
those settings.

3. After a short time, the Chart window on the computer screen should be set up for the experiment.
Channel 2 should be named ‘Event’ and Channel 3 should be named ‘ECG’. Channel 1 has been hidden at
the top of the window.

4. You are now ready to begin the exercises. Remember to ensure that the volunteer is relaxed and sits as
still as possible, arms at rest, hands in lap, to minimize any signal from movement. The Bio Amp cable
has a clip that can be used to fasten the cable and leads to the volunteer’s clothing.

Exercise 1: ECG in a resting volunteer

Objectives

To measure the ECG in a resting volunteer, and analyze the resultant signal. Also, to observe the effects of
slight movement on the signals.

Procedure

Everything should be set up as described in the general notes above.

1. Choose the Bio Amplifier… item from the Channel 3 (ECG) Channel Function pop-up menu. Observe the
signal.

If the ECG cannot be seen, check that all three electrodes are correctly attached. Adjust the range if
necessary. If the signal is noisy and indistinct, make sure that the volunteer is relaxed; consider using the
alternative attachment positions shown in Figure 5.

2. Ask the volunteer to open and close their hands, and then move both arms across the chest. Note that
the trace moves all over the place, and the ECG becomes distorted. This should show you why it is
necessary to keep still and relaxed when recording the ECG.

3. Click the OK button to return to the Chart window.

4. With the volunteer sitting quietly, click the Start button. When you have a suitable trace, type ‘Resting
ECG, ’ and the volunteer’s name, and press the Return key on the keyboard to enter the comment. There
should be a flat line in Channel 2 (Event) at this stage.

5. Click the Stop button to stop Chart recording.

6. If you are saving your files, choose Save from the File menu to save the recording.
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Exercise 2: ECG for a range of volunteers

Objectives

To compare the resting ECG signal from different volunteers.

Procedure

Everything should be set up as described in the general notes above. Record and analyze the ECG signals of
other volunteers in your group as described in Exercise 1.

Exercise 3: ECG and heart sounds

Objectives

To measure and correlate the ECG and heart sounds in a resting volunteer.

Using a stethoscope

Your tutor will briefly demonstrate how to use the stethoscope. Figure 6 shows the essentials.

Figure 6. The correct use of a stethoscope: note the angle of the connection to the endpiece; it shows that
the bell is currently selected.

Procedure

Everything should be set up as described in the general notes above. The stethoscope bell is better than the
diaphragm for this exercise because it blocks off room noise. It still helps if everyone tries to keep the noise
to a minimum. The bell (the cup-shaped end) of the stethoscope should be placed directly on the skin over
the heart to hear the heart sounds clearly. One student should listen using the stethoscope and do the
recording, while the volunteer whose heart sounds are being listened to places the stethoscope bell.

1. Choose the Input Amplifier… item from the Channel 2 (Event) Channel Function pop-up menu.

2. Press and release the push-button switch several times. You should see an obvious deflection. If not,
adjust the range to obtain a deflection that is at least 25% of full scale.

3. Click the OK button to return to the Chart window.

Earpiece
faces
forward

Diaphragm

Skin of subject

Bell
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4. The volunteer should place the bell of the stethoscope on the left side of their chest, using the right
hand. (It is easy enough to do this under one’s shirt.) The stethoscope should be moved to different
positions until the student listening to the stethoscope hears clear heart sounds. The sounds are soft and
therefore room noise must be kept to a minimum. Once clear heart sounds are heard, the volunteer
should hold the stethoscope in place with the right hand while the student using the stethoscope listens
and conducts the recordings.

5. Click the Start button to start recording, and press the push-button switch on hearing ‘lub’ and release it
on ‘dup’.

6. After a few heart beat cycles, click the Stop button to stop recording. Your recording should resemble
Figure 7.

7. If you are saving your files, choose Save from the File menu to save the recording.

Figure 7. An ECG recording, with timed pulses from the push-button switch showing when the heart
sounds were heard.

Analysis

Exercise 1: ECG in a resting volunteer
1. Use the View buttons in the Chart window to set the horizontal compression to 5:1.

2. Scroll through your data and observe the regularly occurring ECG cycles.

3. Measure the amplitudes of four P waves, QRS complexes and T waves from the ECG trace. Move the
Waveform Cursor to the peak of the wave, and read off the amplitude value from the Range/Amplitude
display directly above the ‘ECG’ channel title. Record the average amplitude in Table 1 or a table like it.

4. Using the Marker and Waveform Cursor, measure the durations of four P waves, QRS complexes and
T waves from the ECG trace. Place the Marker on the ECG trace immediately before the wave of interest,
move the Waveform Cursor to the end of the waveform, and read off the time from the Rate/Time
display (as shown in Figure 8). The ‘∆’ symbol indicates that the value is the difference in time between
the positions of the Marker and Waveform Cursor.
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5. Place the Marker before a QRS complex and use the View buttons in the Chart window to compress the
view horizontally to 50:1. Move the Waveform Cursor to the right until roughly a 15-second difference is
shown in the Rate/Time display (this should appear as ‘∆15s’). Count the number of QRS complexes
between the Marker and the Waveform Cursor. Multiply this number by four to calculate resting heart
rate in beats per minute (bpm).

6. Use the View buttons in the Chart window to set the horizontal compression to 10:1. Measure the time
interval (in seconds) between three pairs of adjacent R waves using the Marker and Waveform Cursor.
For each interval, calculate the heart rate using the equation below, and record your results in Table 2 of
your Data Notebook.

Figure 8. An example of the type of recording you should see for Exercise 1: the Marker and Waveform
Cursor are set to measure the duration of the P wave.

• Calculate the average duration for each waveform from four separate ECG cycles and record your
results in Table 1 or a table like it.

Heart rate (beats / minute) =  
60

time interval (seconds)

Exercise 2: ECG for a range of volunteers
Compare the duration and amplitude of the P waves, QRS complexes and T waves between those in your
group and with other members of the class.  Record your results in Table 3 of your Data Notebook.  It may
help to note down the sex and apparent fitness levels of the volunteers.

Exercise 3: ECG and heart sounds
1. Select a region of data with two or three cardiac cycles, by clicking and dragging in the Time axis area

(this will select both of the displayed channels).

2. Select Zoom Window from the Window menu. The Zoom window appears with the Event and ECG signals
overlaid.

3. Note the correlation between Event and ECG signals.

Pointer

Waveform
Cursor

Rate/Time display
Range/Amplitude display

Marker
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If you followed the instructions given earlier, the Event signal should go high (signaling the ‘lub’ sound) very
soon after the QRS complex, and the Event signal should go low (signaling the ‘dup’ sound) at or shortly
after the T wave.
Note any differences from the expected timing of the Event signal.

Data Notebook
Table 1. Results table for the data analysis from Exercise 1.

Component Amplitude (millivolts) Mean Duration (seconds) Mean

P wave

QRS complex

T wave

Table 2. Results table for the heart rate calculation in Exercise 1.

Pair Time Interval (seconds) Heart Rate (beats per minute)

1

2

3

Table 3.  Group data results for Exercise 2.

Person’s name
Mean P

amplidude
(mV)

Mean P
duration (sec)

Mean QRS
amplitude (mV)

Mean QRS
duration (sec)

Mean T
amplitude (mV)

Mean T
duration (sec)
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Study Questions

Exercise 1
1. What can you say about the amplitude of the various waves in different cardiac cycles?

2. The P wave and the QRS complex represent depolarization of the atrial and ventricular muscle
respectively. Why does the QRS complex have the largest amplitude?

3. In step 5 you calculated a heart rate averaged over 15 seconds whereas in step 6 you calculated
‘instantaneous’ heart rates. Explain any differences between these values.

4. The range for a normal resting heart rate is 60 to 90 bpm. A trained athlete could have a resting heart
rate of 45 to 60 bpm. Why might a very fit person have a slower heart rate than someone of average
fitness?

Exercise 2
1. Are the amplitudes and durations of the various waves in different individuals similar or very different?
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2. What variations in heart rate did you observe between individuals?

3. Is there any obvious correlation between heart rate and an individual’s sex or apparent fitness?

Exercise 3
1. Explain why ventricular contraction (systole) and the ‘lub’ sound occur immediately after the QRS

complex.

2. Explain why ventricular relaxation (diastole) and the ‘dup’ sound occur after the T wave.

3. Your recordings probably show some differences from the correct timing of the heart sounds. How do
you think such wrong results occur? What additional apparatus might improve the experiment and
prevent errors in the recorded timing?
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